Outlook Tips & Tricks
Training For Current & New Employees

The workshop will help build the necessary skills needed to begin using Microsoft Outlook 2010. The participant will learn how to create e-mail signatures, work with attachments, and categorize messages by using defining color and creating folders. The participant will also be introduced on how to delegate and share calendars, folders, and their Inbox. Other features introduced in this workshop include how to work with the Voting Buttons, how SharePoint 2010 and Outlook 2010 are integrated, and much more! This training guide may also be helpful as a refresher course for participants already familiar with Outlook.

KUMC – Dykes Library IR Training
12/13/2012
# Table of Contents

- Creating an email signature .................................................. 4
- Handling attachments ............................................................... 4
  - Sending an attachment ......................................................... 5
  - Opening an attachment ....................................................... 5
  - Saving an attachment .......................................................... 5
- Utilizing colors to organize email ............................................ 6
- Rules ...................................................................................... 6
- Email Follow up Flags ............................................................ 7
  - Marking a follow up as complete ......................................... 7
- Managing Mail with folders ................................................... 8
  - Creating folders ................................................................... 8
  - Moving mail to folders ........................................................ 8
  - Deleting folders ................................................................. 8
  - Renaming folders ............................................................... 9
  - Searching for an email .......................................................... 9
- Creating a recurring appointment or event ............................. 9
- Scheduling a meeting ............................................................ 10
  - Responding to a meeting request ......................................... 11
- Using calendar categories ..................................................... 11
- Marking an appointment private ........................................... 12
- Delegation Access .................................................................. 12
  - Simple Delegate Access ..................................................... 13
  - Specific Delegate Access .................................................... 13
  - Permission Levels ............................................................... 14
- Sharing Calendars ................................................................. 14
  - Sharing your Calendar: ...................................................... 14
  - Accessing a Shared Calendar ............................................... 15
- Contacts .................................................................................. 15
  - Creating a contact ............................................................... 15
  - Creating a distribution list ................................................... 15
  - Create a Category ............................................................... 16
  - Add Contacts to a Category .................................................. 16
Create a Category View......................................................................................................................................................................................... 16
Create an E-mail from a Category (Distribution List) ........................................................................................................................................................................ 16
Creating a task........................................................................................................................................................................................................ 17
Using Voting Buttons................................................................................................................................................................................................................ 17
How to create voting buttons in Outlook and export responses in to Excel 2010 .................................................................................................. 19
  Add voting buttons to a message ...................................................................................................................................................... 19
  Review tracking results and voting responses ................................................................................................................................. 20
  Copy voting results to Excel ................................................................................................................................................. 21
FAQ’s ................................................................................................................................................................................................................................. 21
Questions after the training? ................................................................................................................................................................................. 22
Creating an email signature

An e-mail signature is a unique message automatically added to the end of an outgoing e-mail message. It can consist of text and/or pictures. You may create different signatures to be used for new messages or replies and forwards.

1. With the *Inbox* window active, click the **File** tab, **Info**, and select **Options**.
2. At the **Options** dialog box, click the **Mail** tab.
3. Click the **Signatures** button.
4. The **Signatures and Stationery** dialog box will open. Click **New**.
5. When Outlook displays *Create New Signature* dialog box, type the name of your new signature, for example *Reply* or your name.
6. Click the **OK** button.
7. At the **Signatures and Stationery** dialog box, type the text you want displayed as your new signature. For example, name, address, and phone number.
8. Click **OK**.
9. At the **Choose default signature** section of the **Options** dialog box. You may select when you would like your new signature to be used.
   - Make sure your E-mail account is your KUMC address
   - If you want the signature to be used for new Messages, select the signature name for the corresponding drop box.
   - If you would also like the signature to be used for replies and forwards, you may also select it from the drop down menu for that option.
10. Click **OK**.

Handling attachments

In some situations, a simple email message is not sufficient to get the required information to the recipient. In these cases, you may want to attach a file to your email message. Outlook allows you to attach almost any kind of file to your message. You may want to send a Word document, an Excel worksheet, a picture, or any number of file types.
Sending an attachment

1. Create a new email. Enter the recipients of the message and type a subject.
2. Click the **Attach File** button, or click the attachment icon from the Include group on the Message tab located on the Untitled – Message window on the ribbon.
3. The **Attach File** dialog box will open. Locate the file that you would like to send and select it.
4. Click the **Insert** button. A new line titled **Attached...** will appear below the subject. It will include an icon for the file type you are sending and the name and size of the document. You are limited to sending 30MB of attachments in a single email from your Outlook account.
5. Type the text in the body of the message. Be sure to state that you are sending an attachment.
6. Click **Send**.

Opening an attachment

1. When receiving an email with an attachment, the **paper clip** icon will be visible in the message header.
2. Open the email.
3. Double-click the attachment icon on the attachment line after opening the E-mail message. This icon will be different, depending on the type of file sent.
4. You may save the file to the location of your choice or close it when you are finished viewing the document.

Saving an attachment

In some instances it is necessary to save attachments. It may be a file you need to edit, or you may prefer not to store files in your email, but rather on your computer’s hard drive or network drive.

1. When receiving an email the **paper clip** icon in the message heading will indicate the email message contains a file attachment.
2. Open the email.
3. Right-click the **attachment** icon on the attachment line. When Outlook displays the **Drop Down Menu**, click **Save As**.
4. The **Save Attachment** dialog box will open. At the **Save Attachment** window select the location where you would like to store the document. You can also change the name of the document if you wish in
the File name field. In some cases you may even wish to save the document as a different type by selecting the appropriate action from the drop down menu in the Save as type field.

5. Click Save.

Utilizing colors to organize email

Use this mode to apply a specific color to messages with a specific sender or recipient. Outlook changes the color of the message header in the Inbox accordingly. You can also specify the color of messages sent only to you. Color selection and the meaning of each color are entirely at the discretion of the user.

1. With the Inbox window active, click the Home tab and within the Tabs group, click the Categorize down arrow.
2. Click the All Categories option from the drop down menu.
3. From the Color Categories dialog box that appears, you can click to rename any of the available categories, create a new category, assign colors, and even assign keyboard Shortcut Keys (F2 through F12) to a category.
4. Click the OK button when finished setting up the categories to your Personal liking. For example, click on the ‘blue’ category and rename it to ‘Personal’, and then click the OK button.
5. Next, you will learn how to create a Rule so that any e-mail messages received from an outside personal contact will be flagged with the ‘Personal category’ you just created.

Rules

Use this mode to apply a specific rules to messages with a specific sender or recipient. Outlook changes the color of the message header in the Inbox accordingly. Color selection and the meaning of each color are entirely at the discretion of the user.

1. With the Inbox window active, click the Home tab and within the Tabs group, click the Rules down arrow.
2. Click the Manage Rules & Alerts option from the drop down menu.
3. Click the New Rule menu option.
4. You could create a Rule to move a recipient or group of recipients to a specific folder. Also you can create a rule to move the message based on the subject to a specific folder. For this example, click the ‘Flag message from someone for follow-up’ within the Stay Organized section, and then click the Next button.
5. In the Step 2: Edit the rule description (click an underlined value), click on the ‘people or public group’ link.

6. Select the recipient from either the Global Address Book, your department contact address book, or even from outside the organization such as Windows Live account. Make sure to put the recipient name you wish to Flag for incoming messages. Click the OK button.

7. Once again, in the Step 2: section, click the ‘follow up at this time’ link and set your personal options on how you want these messages flagged. Click the OK button.

8. Click the Next button.

9. In this Step 1: section, click to place a checkmark in the ‘assigned to category ‘Personal’.

10. Click Next, click Next, and then click Finish. Click Apply, then click OK.

Email Follow up Flags

You can use follow up flags to help you to organize your emails. If you receive an email that you need to take action on at a later date, you can flag it and set a reminder so you will remember to complete the task. Flags can be assigned one of six different colors.

1. Right click an email message and select Follow-up, Add reminder from the shortcut menu. The Custom dialog box will open.

2. At the Flag to drop down list, select the applicable task related to the message. You may select such options as call or reply.

3. If you would like a reminder to pop-up, select a date in the Reminder: field. Making sure you have placed a checkmark to activate this reminder. You may also select a specific time.

4. Click OK. A flag will appear in the right of the e-mail detail line.

Marking a follow up as complete

1. Right click on the email message which contains the flag you would like to mark as complete.

2. From the shortcut menu select Follow-up, and then select Mark Complete.

   The colored flag will be replaced with a check mark.
Managing Mail with folders

Outlook provides several ways to organize your data. Creating folders allows you to store specific emails based on their subject. It helps to keep your Inbox neat and makes it easy to find emails when you need them.

Creating folders

1. Click the Documents folder within the navigation pane.
2. Right-click the Documents folder and then select the New Folder option.
3. In the Folder contains box Mail and Post items should be selected. where you would like to place the folded. For this example, click the Documents folder.
4. In the Create a New Folder dialog box type the Name of the new folder and where you would like to place the folder. For this example, click the Documents folder.
5. Click OK. The folder will appear under the folder list under Inbox on the left side of your screen.

Moving mail to folders

Once you have created your new folder you will want to start organizing your email.

1. Select the folder that includes the message you want to move, this will most likely be your Inbox.
2. After the folder opens, right-click the message you would like to move and click Move from the shortcut menu, then ‘mouse over’ and select ‘Other Folder’.
3. Click the folder that you want to move the message to, such as the Documents folder or the new folder that you previously created.

Deleting folders

You may decide you no longer have use for a folder you created. If so, you may delete the folder. This will delete the contents as well as the folder.
1. Right Click on the folder you would like to delete.
2. Select **Delete Folder** from the shortcut menu.
3. Click **Yes**.

### Renaming folders

Perhaps a person’s name has change, or you misspelled a folder name. In this instance you may need to rename a folder.

1. Right Click on the folder you would like to rename.
2. Click **Rename Folder**.
3. Type the new name for the folder.
4. Press **Enter** on your keyboard.

### Searching for an email

1. Click within the **Search** Inbox (Ctrl+E) field just above the Inbox message column headings and type the name of the recipient you are searching for and then click the Search icon (magnifying glass) or just press **Enter**.
2. Also, you can search for message by clicking the From, Subject, Received, Or Size column headings to filter your Inbox messages.
3. Click the **Received** column heading to restore your view to display the Inbox messages by received date and time.

### Creating a recurring appointment or event

1. Open the appointment or event you want to make recurring or create a new appointment or event.
2. Click the **Recurrence** button within the Options group on the ribbon.
3. Select a start and end time for the appointment.
4. At the **Appointment Recurrence** dialog box:
   - Select the frequency of the meeting (Daily, Weekly, Monthly or Yearly).
   - Establish how often the meeting will occur, once every week, once every two weeks? The **Recurrence pattern** fields allow you to set the frequency.
   - Select the day(s) of week the meeting will occur.
   - In the Range of recurrence section, check to be sure the start date is
correct and select one of the radio buttons establishing when the last meeting will occur.
5. Click **OK**.
6. Click **Save and Close** in the calendar entry.

### Scheduling a meeting

In the calendar you can schedule regular appointments, all day, multi-day events or meetings. An appointment becomes a meeting when you invite other people, which requires coordinating others’ schedules.

1. Click on your **Calendar** from the navigation pane and then on the **Home** tab, within the **New** group, click the **New Meeting** icon.
2. Click **Add Others Æ Add from Address Book**.
3. In the **To** field begin typing the first and last name of a person you want to invite to the meeting. Their name will appear in the list. If not click on the **To** button and search the Outlook Address Book or your departments Contact Address Book for the recipient or group of recipients to invite to the meeting.
4. Select the name of the person you are inviting in the list and click **Required** or **Optional**. The Required and Optional attendees appear in the **To** box on the **Appointment** tab of the meeting entry.
5. Once you have selected all of your attendees, click **OK**.
6. You can use the **Scheduling Assistant** within the Show group from the Meeting tab to visually see when selected invitees are Busy, Tentative, or Out of Office. You can use the ‘green’ and ‘red’ borders to resize the time of the meeting by left-click and dragging the border. Or you can left-click and drag the meeting time range to another time of day when invitees are not busy.
7. In the **Subject** box, type a description.
8. Enter the location of the meeting in the **Location** box
9. If you want to make the meeting recurring, click **Recurrence**, then select the recurrence pattern. Click the **Send** button to e-mail the attendees the meeting request.

**Responding to a meeting request**

When you send a meeting request, a meeting request e-mail message is sent to the invited attendees. This message allows the attendees to accept, tentatively accept, reject the meeting invitation, propose a new time for the meeting, or include a message in the reply.

1. Open the meeting request.
2. Click on **Accept**, **Tentative**, **Decline** or **Propose New Time**.

   - Selecting **Accept** will make an entry on your calendar.
   - Selecting **Tentative** will make an entry on your calendar, but it will not be blocked as “busy”.
   - Selecting **Decline** will not place an entry on your calendar.
   - Selecting **Propose New Time** will allow you to search for a new time when all invitees are available.
   - Regardless of which option you select an email will be sent to the meeting organizer letting them know your status.

3. If you select **Accept**, **Tentative** or **Decline** you will be given you three options. Select the option that is applicable to you.
   - **Edit the response before sending** - allows you to send additional comments with your response.
   - **Send the response now** - sends the response only, with no additional comments.
   - **Do not send a response** - cancels your response.

4. If you selected **Edit the response before sending**, you will be given an email form in which to type your comments, then click **Send**.

**Using calendar categories**
The Label drop-down list on the appointment form shows the different color labels you can assign to an appointment as a visual cue to indicate the purpose of the appointment, its importance or requirement. Outlook has predefined labels created for you, however you may change the text of any labels.

1. Create a new appointment or open a previously scheduled appointment.
2. At the Categories drop-down list, select the desired category.
3. When you have completed all the fields for your meeting entry click Save and Close. It will be highlighted in the selected color.

Marking an appointment private

Outlook gives you the option to make an appointment private. If you choose to do this, a person with permission to view your calendar will see the time is blocked out on your calendar but will not be able to see the appointment details.

1. Create or open the appointment or meeting that you want make private.
2. Select the Private check box in the lower right corner.
3. When all the fields in your calendar entry are completed, click Save and Close.

Delegation Access

Delegate access allows a person to share a folder or sub-folder of Mail, Calendar, Contacts, or Tasks to other University or UPK users. Like GroupWise it requires the owner to grant access and then for the recipient to take access. Under “Simple Delegate Access” below, a person can share any folder with other users very easily. However, it is broad in that everything in the folder is shared and not just a single sub folder and the rights given are limited. An alternate method of giving access is to select a folder or a specific sub folder and then delegate access. This allows much more precision in granting access.

Example: A user has a Contact folder and inside of the Contact folder are two more folders called “Work” and “Private”. Using “Simple Delegate Access”, all three folders are shared to others. Using the other method, the owner can choose to share just the “Work” folder and there is much more control over what the users can and can’t do.
**TIP:** If a file is dragged into a folder that is shared, it will not be shared.

**TIP:** If a folder is created inside of a shared folder, it will inherit the rights of the parent folder.

### Simple Delegate Access

1. Click **File, Info, Account Settings, Delegate Access.**
2. Click **Add**
3. Search for the user(s) you want to give access to and click **Add** -> and then **OK**.
4. Use drop downs to give access to entire areas.
5. Select check boxes for desired options.
6. Click **OK** twice when done.

### Specific Delegate Access

1. Select a folder
2. Click the **Folder** tab
3. Click **Folder Permissions or Calendar Permissions** button
4. Click **Add**.
5. Search for the user(s) you want to give access to and click **Add** -> and then **OK**.
6. There are two ways to select permissions
7. Permissions Level has 9 preset levels of rights (see “Permissions Levels” below).
8. Select specific rights by selecting from the options listed in radio buttons and check boxes.
9. Click **OK** when done.
Permission Levels

The following table displays the permission levels and the definitions of each:

<table>
<thead>
<tr>
<th>Role</th>
<th>Permission Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Create, read, modify, and delete all items and files, and create subfolders. As the folder owner, you can change the permission levels others have for the folder.</td>
</tr>
<tr>
<td>Publishing Editor</td>
<td>Create, read, modify, and delete all items and files, and create subfolders.</td>
</tr>
<tr>
<td>Editor</td>
<td>Create, read, modify, and delete all items and files.</td>
</tr>
<tr>
<td>Publishing Author</td>
<td>Create and read items and files, create subfolders, and modify and delete items and files you create.</td>
</tr>
<tr>
<td>Author</td>
<td>Create and read items and files, and modify and delete items and files you create.</td>
</tr>
<tr>
<td>Non editing Author</td>
<td>Create and read items and files, and delete items and files you create.</td>
</tr>
<tr>
<td>Reviewer</td>
<td>Read items and files only.</td>
</tr>
<tr>
<td>Contributor</td>
<td>Create items and files only. The contents of the folder do not appear.</td>
</tr>
<tr>
<td>Custom</td>
<td>Perform activities defined by the folder owner.</td>
</tr>
<tr>
<td>None</td>
<td>You have no permission. You can't open the folder.</td>
</tr>
</tbody>
</table>

Sharing Calendars

There might be a time when you will want to share your calendar with other people. The following steps will describe the necessary steps to complete this task.

Sharing your Calendar:

**Step Action to Take in Outlook 2010**

1. Select the Calendar link in the Navigation Pane.
2. On the **Home** Ribbon, click **Share Calendar** button.
3. Click in the ‘To:’ field.
4. Type the name or email address of the recipient.
5. Click the **Details** drop-down button.
6. Select the details level you wish to grant.
7. Click the **Send** button.
8. Click **Yes** to share the calendar.

**Accessing a Shared Calendar**

**Step  Action to Take in Outlook 2010**

1. You will receive an email.
2. Open the email message.
3. Click the **Open this Calendar** button.
4. You now see the shared calendar.

**Contacts**

Contacts is an Outlook tool to help you organize and store addresses, phone numbers, email addresses and other information about people you may need to communicate with.

**Creating a contact**

1. Click **Contact** from the navigation pane.
2. Click **New Contact** from the **Home** tab on the ribbon in the **New** group.
3. Enter the information you want to include for the contact.
   - You can specify how you want the contact’s name to **Display** in the **TO**: line of a message by typing the name in the **Display As** box.
   - To enter multiple entries in a field such as more than one address or email address, click the drop down arrow next to the field.
4. When you have entered all the data for your contact, click **Save and Close**.

**Creating a distribution list**

**Overview**

A typical group in Outlook is fairly small. When a larger group is needed, a category can be used to get around the limitations.

1. Every member in the group must be a Contact in Outlook
2. Create a Category for the distribution list (see Create a Category below)
3. Add Contacts (member of the distribution list) to the Category (see Add Contacts to a Category below). This will typically be repeated many times.
4. Create a view in the Contacts folder to show just members of the Category (see Create a Category View below)
5. When ready to use the Distribution List, create an e-mail from the Category (see Create an E-mail from a Category below)
Create a Category

1. From any folder, click Categorize and All Categories ...
2. Click New ...
3. Type in a name for your Distribution List
4. Select a color (if desired)
5. Click OK

Add Contacts to a Category

1. Right click on a Contact in any of the Contact folders to be added to the Distribution List
2. Click Categorize and then click on the Distribution List previously created
3. Repeat steps 1-2 as needed
4. A contact can be in several Categories (Distribution Lists in this case)

Create a Category View

1. View the Contacts Folder
2. Click (right side of the “Current View” section of the ribbon)
3. Click Manage Views ...
4. Click New ...
5. Type in a name for your Category (Distribution List)
6. Choose a “Type of View” like Card
7. Click OK twice

Create an E-mail from a Category (Distribution List)

1. Open any Contact folder
2. In the “Current View” section of the ribbon, click on the name of the Category (Distribution List) to send an e-mail to
3. The contacts listed should be just the members of the Category (Distribution List)
4. Using the keyboard, hit CTRL-A and all of the contacts should be selected
5. Click E-Mail
6. Want to send as BCC... and not To... ?
7. Click the Options tab and then Bcc to show the BCC:
8. Place the cursor at the end of all the names in the To... box
9. Hit CTRL-A to select all Contacts and CTRL-X to “cut” the names from the
box. Place the cursor in the Bcc: box and hit CTRL-V to “paste” the names in the box and continue creating the e-mail.

Creating a task

Outlook provides the way to track your task. This feature is an effective way to create and manages tasks. You can create a one-time task or recurring task. There is the ability to track the amount of time spent on a particular task, as well as keep details.

1. Select **Task** from the Navigation pane. From the Home tab, click New Task from the New group on the ribbon.
2. In the **Subject box**, type a task name.
3. If you would like to assign the task to someone you can click the **Assign Task** button from the Task tab and the Manage Task group.
   - In the **To:** field type the email of the address of the person you would like to assign the task to.
   - You may choose to deselect the update options on the task if you do not want to be updated on its status.
4. You may select a due date, start date and priority, but none of these fields are required.
5. In the body of the task, type any relevant details.
6. Click Save & Close when finished.

Using Voting Buttons

MS Outlook 2010 Application provides us with an Option that enables us to add Voting Buttons to the mails that we send. The Voting Buttons allows people who are reading the message to vote for any options that you specify in the Mail. Once the people vote for any of the Options, the Votes get back to you as a special Email message. Follow these simple steps to achieve the above said cool feature of MS Outlook 2010 application.

1. Open your MS Outlook Account; click on the “Home Tab” in the Ribbon and then under the Home tab, in the ‘New’ category, click on the “New E-mail” icon.
2. Now in the “New E-mail” Window that appears on the screen, click on the ‘Options’ tab and then under the Option tab click on the “Voting Buttons” icon that you find in the ‘Tracking’ category group.
3. Once you click on the Voting Buttons icon, you will get a list of Options to choose from. Click on the Option that suits your requirement.

6. Once you chose the Option, you will get a message in the E-mail window saying that ‘You have added voting buttons to this message’.

6. **Now send the message to the desired destinations and the people who receives the mail can vote for one of the Options that you specified in the mail. In order to vote, you click on the 'Vote icon' in the Response category group and then choose any of the Options from the list thus opened.**

7. Once a person has voted for any of the option, a small dialogue box appears on the screen asking him/her to whether to send the response or not. Click on the radio button that says ‘Send the Response now’.

8. Now the sender who sent the mail will get a special message in his/her inbox stating for what Option the people voted for.
So, this is how you can use the Voting Buttons feature of the MS Outlook 2010 Application to send Voting Options with your E-mail messages.

How to create voting buttons in Outlook and export responses in to Excel 2010

Voting buttons work in all versions of Microsoft Outlook, however, OWA (Outlook Web Access) cannot utilize the Voting Button feature.

**Add voting buttons to a message**

1. In the message, click **Options**.

2. Select the **Use voting buttons** check box, and then click the voting button names you want to use in the box.
3. To create your own voting button names, delete the default button names, and then type any text you want. Separate the button names with semicolons.

4. Under Delivery options, select the Save sent message to check box. To select a folder other than the Sent Items folder, click Browse.

   **NOTE**: After all destination recipients respond with their choices you must click on Sent Items from the Navigation pane, and open the original message that you sent containing the voting options to view all the respondents choices. Remember to click the Tracking tab to view the results.

5. Click **Close**, and then click **Send**.

**Review tracking results and voting responses**

1. Open the original message you are tracking. This message is usually located in the Sent Items folder (as mentioned earlier).

2. Click the **Tracking** tab.

   ![Tracking Tab](image)

   **Note**: By default, responses that do not contain comments are recorded in the original message, and responses that contain comments are kept in the Inbox. You can have Microsoft Outlook automatically delete the blank responses.
Copy voting results to Excel

To view the voting results do the following:

- Open the original message you are tracking. This message is usually located in the Sent Items folder.
- Click the Tracking tab.

1. Select the responses you want to copy. Do one of the following:
   - All rows – click the first row, hold down the SHIFT, and then click the last row.
   - Nonadjacent rows – click the first row, hold down the CTRL, and then click additional rows.
2. Copy the responses.
3. Switch to Microsoft Excel.
4. On the Edit menu, click Paste.

FAQ’s

Q: We have given access but when we send emails from that account it is from our personal account is that the way it’s set up on outlook? And if I delete something from that inbox it goes to my personal deleted emails. Is that just the way it works?

A: Yes, that is how it works. We did find an article where there may be a work around but we haven’t had a chance to setup and test. What you are currently seeing though is normal operation. Another option in some areas, the user has been logging in as the generic account and sending directly from the account so the sent items, etc. stay with the account not the user’s personal email account.

Q: How does SharePoint 2010 integrate with Outlook 2010 when creating Workflow Tasks?

A: There is a New Button in Outlook that launches the approval process. So rather than the user clicking on a hyperlink under instruction #3 in the picture below, the user should click on the “Open this Task” button on the Ribbon.
Questions after the training?

- Help Desk Support – 8-7995
- E-Learning – myKUMC/Training/E-Learning
  
  **Microsoft E-Learning for Business**
  Self-paced tutorials for Microsoft Office and SharePoint applications. Signing in requires a personal Windows Live account. First-time users, activate your KUMC email address using Access Code **IWO0A06C46** *(that's the letter O followed by the number zero, with a zero after the A)*.

- Barracuda – SPAM protection - [https://spamfirewall.kumc.edu](https://spamfirewall.kumc.edu)

- Securefiles – Solution for large attachments - [https://securefiles.kumc.edu](https://securefiles.kumc.edu)

Questions Not Answered?

Please complete feedback form at: 

[https://redcap.kumc.edu/surveys/?s=WfQ6h2](https://redcap.kumc.edu/surveys/?s=WfQ6h2)

Contact Information: Byron Johns, IR Training Coordinator, [bjohns@kumc.edu](mailto:bjohns@kumc.edu), 588-7117